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JDemetra+ in Luxembourg’s Quarterly National Accounts 
 

Overview 
 
This document describes in detail how seasonally and calendar adjusted Quarterly 
National Accounts are compiled with the help of JDemetra+ at STATEC (National 
Statistical Institute of Luxembourg). As soon as the production version of JDemetra+ is 
available (probably in November 2013) Quarterly National Accounts, Employment and 
Turnover will be seasonally/calendar adjusted/forecasted using JDemetra+.  
 
As an example, let’s take a look at the procedure for compiling adjusted Quarterly 
National Accounts.  
 
First a new JDemetra+ session needs to be opened.  
 

 
 
Upon opening, JDemetra+ presents 2 default windows:  
 
-the Providers Window and 
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-the Workspace Window.  
 
In the Providers Window the input data will be charged. It can be a MySql database, an 
ODBC DSN, an Oracle database, a SDMX file, a Spreadsheet, a TSW, a Txt file, an 
USBC or an Xml file. Most data used at STATEC are in Excel 2010 format.  
 
In the Workspace window we can select a seasonal adjustment model of the family 
tramoseats or x13.  
 

 
 

Plugins 
 
First you should make sure that all the installed plugins in JDemetra+ are activated. To do 
so go to -> Tools -> Plugins.  
 

 
 
Check that all of the 11 installed plugins are active (  sign after the name of the plugin).  
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If you want to add self-made plugins, go to the flag Downloaded and click on the  
Add Plugins… button. Browse for the plugins you want to insert. These are now added to 
the installed plugins and need to be activated.  
 

 
 
Note that the plugins are essential to JDemetra+. They are in fact the core element of 
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JDemetra+ and the main difference to the Demetra+.net version.  
 

Charging the national calendar 
 
As JDemetra+ doesn’t have any predefined calendars, like in old Demetra 2.3, the 
national calendar needs to be charged manually. To do so, right-click on the Calendars 
icon in the Workspace Window and select -> Add Calendar and then -> National:  
 

 
 
In the following window, give the calendar a name (f. ex. Luxembourg). Upon clicking 
on the + sign, you have the choice between Fixed, Easter related, Fixed Week and 
Special Day. Luxembourg has:  
 

• 2 Fixed holidays: National Day (23 June) and St. Stephen’s day (26 December). 
These have to be inserted manually in the calendar. Nevertheless, you can add St. 
Stephen’s day also as Special Day Christmas with Offset +1, which means the 
day after Christmas.  
 

• no Easter Related Days, as this effect is not so important to Luxembourg’s 
economy. In fact Christmas, is a Holiday where much more revenue from food, 
presents and decoration is made. Easter Related Days determine the days before 
and/or after Easter where an Easter effect is present. As tramoseats was developed 
in Spain, where the Easter effect is very important, special attention has been 
given to this holiday in the program.  
 

• no Fixed Weeks, as this effect is not so important to Luxembourg’s economy, 
except for the construction branch. Fixed Weeks, can f. ex. be used when the 
activity of a whole branch is low for one or more weeks, like in Luxembourg 
during the collective leave period (in 2012: 27.07.-19.08. and 22.12.-09.01.)  
 

• 10 Special Days: New Year, Easter, Easter Monday, Ascension, Pentecost, Whit 
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Monday, May Day, Assumption, All Saints Day and Christmas. These have to be 
selected on the right side of the window under -> Special Day -> Day event. Note 
that the Special Days have a Weight function, under ->Event -> Weight, where 
you can assign the impact of a holiday on the national economy, f. ex. 0.5 for 
half-day off and a given percentage if only part of the economy doesn’t work. 
They also have an Offset function, under -> Special Day -> Offset, where you can 
determine the days before and/or after the Special Day, where an economic effect 
is present, f. ex. if all or some branches of the economy don’t work the day before 
or after a Special Day. In Luxembourg, the bank sector has a day-off on Good 
Friday, so you could treat this as a Special Day Good Friday with Weight 0.17 as 
the bank sector contributes to 17% to the GDP of Luxembourg. Another example 
is Christmas Eve, a day on which most people work only half-days, so we could 
consider Christmas Eve as Special Day Christmas with Offset -1 and Weight 0.5. 
In practice, half-days and days, where only part of the economy have a day-off, 
have no effect on the Calendar adjustment. So this is omitted in Luxembourg’s 
calendar.  

 
Note also that for all of these holidays a starting date and an ending date can be defined 
under -> Event -> Start -> End. This is f. ex. useful if a national holiday is 
proclaimed/abolished (f. ex. Victory in Europe Day (8th of May) has been a national 
holiday in France from 1953 to 1959, was then abolished and became again a national 
holiday from 1982 on). However this is not relevant for Luxembourg.  
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Clicking on the OK button will add your new calendar under the Calendars icon in the 
Workspace window. Note that Calendars can be edited, cloned or removed by right-
clicking on the calendar’s name.  
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Loading the data 
 
The following type of input files can be loaded in JDemetra+:  
 
-ODBC DSNs (Open Database Connectivity Data Source Name) 
-SDMX files (Statistical Data and Metadata eXchange) 
-Spreadsheets (Excel files) 
-TSW (TestStand Workspace) 
-Txt files (Text files) 
-USBC (files of the x13 type) 
-Xml files (Extensible Markup Language).  
 
Let’s consider f. ex. an Excel input file. This file needs to have the following structure:  
The dates have to be put either in the first column (column A) or the first row (row 1), in 
contrast of the titles.  
The titles of the series have to be put either in the first row (row 1) or in the first column 
(column A), in contrast to the dates. Values must be entered from cell B2 on.  
Empty cells will be treated as missing values. Series that contain only zeros, will lead to 
empty series in the output. Blank series will be suppressed in the output.  
Note that the first cell (cell A1) of the Excel input file can contain either nothing or 
anything that you like. It is no more vital that the first cell is empty like in the .net version 
of Demetra+.  
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To load this type of Excel file, right-click on the Spreadsheets icon in the Providers 
Window, then select Open.  
 

 
 
Then browse for the folder, using the … button on the right under Spreadsheet file.  
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The folder will then appear in the tree under Spreadsheets:  
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In the drop-down structure, you will see the path of the folder, the name of the sheet 
(COP05) and the name of the series in the sheet (TRB1G VA, TRB1G VB_E, TRB1G 
VC, TRB1G VF etc.).  
 
If you want to close a file, right-click on the file path in the Providers Window, then 
select Close.  
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Seasonal adjustment with JDemetra+ 
 
Once you have uploaded the series in the Providers Window, you can start with the 
seasonal adjustment procedure. You can chose between the following specifications in 
the Workspace Window:  
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Description of the different specifications:  
 
for tramoseats:  
 
RSA0 (airline model (0,1,1)(0,1,1)) 
RSA1 (log test, outlier detection, airline model) 
RSA2 (log test, test on the presence of working days (1 parameter, working day or not), 

Easter effect, outlier detection, airline model) 
RSA3 (log test, outlier detection, automatic identification of the model) 
RSA4 (log test, test on the presence of working days (1 parameter), Easter effect, outlier 

detection, automatic model identification) 
RSA5 (log test, test on the presence of trading days (6 parameters, Monday, Tuesday, 

etc.), Easter effect, outlier detection, automatic model identification) 
 
and for x13:  
 
X11 (without any pre-adjustment) 
RSA1 (log test, outlier detection, airline model) 
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RSA2C (log test, test on the presence of working days (1 parameter, working day or not), 
Easter effect, outlier detection, airline model, pre-adjustement for leap year if logarithmic 
transformation has been used) 
RSA3 (log test, outlier detection, automatic model identification) 
RSA4c (log test, test on the presence of working days (1 parameter), Easter effect, outlier 
detection, automatic model identification, pre-adjustement for leap year if logarithmic 
transformation has been used) 
RSA5c (log test, test on the presence of trading days (6 parameters, Monday, Tuesday, 
etc.), Easter effect, outlier detection, automatic model identification, pre-adjustement for 
leap year if logarithmic transformation has been used).  
 
For the compilation of Quarterly National Accounts, STATEC uses x13 with a maximum 
of parameters, so the specification RSA5c. In addition, the calendar for Luxembourg, 
previously defined, needs to be integrated. To do so, clone the RSA5c specification by 
right-clicking on it and selecting Clone.  
 

 
 
A new X13Spec-1 specification is then created.  
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Double-click on the newly created specification X13Spec-1 specification and add the 
National Calendar for Luxembourg. To do so, go to the node -> Regression -> Calendar  
-> tradingDays -> option, where you select Holidays instead of Default and -> holidays, 
where you select your previously defined National Calendar (here: Luxembourg) instead 
of Default.  
 

 
 
Note that if you want to benchmark all of your series, it is easiest to do this in this 
window. Go to the node -> Benchmarking where you check the Is enabled box. Then 
under -> Target, select either Original or CalendarAdjusted, whether you want the 
adjusted quarterly series to be fitted to the sum of quarters of the original data or to the 
sum of quarters of the calendar adjusted data.  
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However no benchmarking is done for Luxembourg’s Quarterly National Accounts, as 
this would distort the series patterns and lead to stronger revisions in quarterly data.  
 
Now the new specification X13Spec-1 contains all the parameters of the RSA5c 
specification as well as the National calendar for Luxembourg.  
 
If you want, you can rename the newly created specification by right-clicking on it and 
then selecting ->Rename.  
 
Now everything is ready for seasonal adjustment of the series.  
 
For single analysis you have 2 options:  

• either you right-click on the X13Spec-1 specification and choose Create 
Document.  
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• or you go via the menu Statistical methods -> Seasonal Adjustment -> Single 
Analysis -> X13.  

 

 
 
Now an X13Doc-1 window opens on the right where you can drop the data of only one 
series (under Drop data here). This series is directly seasonally adjusted and results are 
displayed in the window on the right.  
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However we usually need to seasonally adjust a multitude of time series. To do so, we 
only have one option:  
Go to the menu Statistical methods -> Seasonal Adjustment -> Multi Processing -> New.  
 

 
 
A new window SAProcessing-1 opens now. Drop the data from the Providers Window in 
the empty space in the SAProcessing_1 window by drag and dropping the Excel sheet 
icon with all the time series. By default the specification will be RSA4. If you want a 
different specification, select all the series in this window, then right-click and select -> 
Specification… and chose the one you want.  
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Note that the series are not processed yet. To seasonally adjust the series you need to 
click the  button. Seasonal adjustment is quite fast in new JDemetra+ and the results 
will be displayed immediately.  
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The seasonally adjusted series can be of 6 different Quality types:  

• Good,  
• Uncertain,  
• Bad (no logical error, but bad quality of the results, however they could be used),  
• Severe (no logical error, but SAProcessing should be rejected for statistical 

reasons),  
• Error (error in the results, SAProcessing should be rejected) or  
• Missing (unprocessed test, meaningless test, failure in execution of the test f. ex. 

for series containing only the values 0).  
Empty series (with no values at all), will be dropped in the seasonal adjustment procedure 
and in the output.  
The series with Severe Quality or Error must be treated case by case. If you want to 
accept a series with Severe Quality or Error, select the series, right-click and select 
Accept.  
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This option can only be used for unimportant series that do not affect GDP and are not 
taken into account in the results analysis.  
 
By clicking on the Specifications button on the top right in the SAProcessing-1 window, 
a window appears down right where you can change many parameters for each series (f. 
ex. the series span, the model span, the calendar, the ARIMA model chosen, the level of 
significance of the tests, the boundaries for the detection of extreme values, whether or 
not to benchmark etc.) We will call this window “Spec Window” in the following.  
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Usually this window is left untouched. However in the case of a detailed analysis for a 
series with Severe Quality, the parameters in this window can be adapted in order to 
improve the quality of the adjustment. You should also check then the drop-down menu 
down left which gives you a detailed analysis of the adjustment performed. We will call 
this menu “Results Menu” in the following. Note that in this document, we consider the 
Spec Window and the Results Menu only for an x13 adjustment. They are different for a 
tramoseats adjustment.  
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First we will have a look at the Results Menu.  
 

 Specifications 
Here is a summary of the chosen specification with all the parameters and options. 
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 Main results 
Pre-processing (RegArima)  
Summary 
Here you will find amongst others the estimation span, the number of observations, if the 



 24 

series have been log-transformed, if trading days have been detected, if an Easter effect 
has been detected and the number of outliers detected.  
 

 
 
Diagnostics 
Here you will find amongst others the quality of the adjustment (Good, Uncertain, Bad, 
Severe, Error or Missing), if residual seasonality is still present in the series, the m-
statistics to evaluate the quality of the seasonal adjustment, the regarima residuals, the 
visual spectral analysis to identify spectral peaks in seasonal and trading day components 
and the annual totals to compare the annual totals of the original series with those of the 
seasonally adjusted series.  
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Beneath are displayed 2 charts: the same chart as you can find under Chart and the S-I 
ratio chart.  
 

 
 

 Chart shows the graphs of the original, seasonally adjusted and trend series.  
 Table shows the data of the original (y), seasonally adjusted (sa) and trend series (t) 

and the seasonal (s) and irregular (i) factors.  
 S-I ratio chart is very useful for analysing the development of the seasonal pattern, i.e. 

to detect unstable or moving seasonal factors. The S-I ratios (dots in the graph) are 
calculated as the ratio from the original series to the trend, so they present an estimate of 
the detrended series. The blues curves in the graph represent the final seasonal factors 
and the red straight lines represent the average mean factor for each quarter.  
 

 Pre-processing 
Summary 
Here you will find again the summary of the Pre-Processing that you have already seen 
under Main results Pre-processing (RegArima) Summary.  
Final model 
Here you will find an estimation of the model by Exact Likelihood Estimation. Akaike 
Information Criterion (AIC), small-sample-size corrected version of Akaike Information 
Criterion (AICC) and Bayesian Information Criterion (BIC) are used to select the best 
model. The results of the outlier detection are also shown: JDemetra+ detects 3 types of 
outliers: TC (Transitory Change), LS (Level Shift) and AO (Additive Outlier).  
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 Forecasts shows the forecasts of the original series (y_f) and their confidence interval.  
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 Out-of-sample test: The model is re-estimated on linearized series for a given number 
(<= (real number of observations-x)) of first observations and x quarter ahead forecasts 
and the Mean and MSE (comparison between (MS of) forecast errors and (MS of) 
residuals) are computed.  
 

 Regressors shows the table with all the deterministic regressors used within the 
RegArima part (trading days, leap year effect, outliers, Easter effect, ramps, intervention 
variables and user-defined variables) with their type, date and value.  
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 Arima 
Here you will find a spectral plot with peaks at frequencies 0, Pi/2 and Pi due to the 
seasonality of the quarterly data. The estimated coefficients of the parameters of the 
RegArima model are shown as well (regular and seasonal AR and MA).  
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 Pre-adjustment series shows a table with the series estimated by the RegArima part. In 
our tests the following series appeared:  
 

o Interpolated series (yc) 
o Linearized series (y_lin) 
o Series corrected for calendar effect (ycal) 
o Deterministic component (det) 
o Calendar effect (cal) 
o Trading day effect (tde) 
o Easter effect (ee) 
o Outliers effect on the irregular component (out_i) 
o Outliers effect on the trend component (out_t) 
o Total outliers effect (out) 
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 Residuals shows the graph and the table of the residuals from the model.  
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 Statistics 
Analysis of the residuals 
Summary 
Here you will find 4 different tests on the residuals (normality, independence, 
randomness and linearity). The Portmanteau tests of Ljung-Box and Box-Pierce are used 
for the computation of tests on autocorrelation of the residuals.  

 
 
Details 
Here you will find the details on the tests from the summary above. Besides the p-value 
you can also see the autocorrelation, standard deviation and distribution.  
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 Distribution shows the autocorrelogram (ACG) and the partial autocorrelogram 
(PACG) and a histogram of the residuals estimated from RegArima model. The grey 
dotted lines in the ACG and PACG represent the confidence intervals. As long as the 
(partial) autocorrelation coefficient is in the confidence interval, everything is all right. 
However you should pay special attention to the series, where the (partial) 
autocorrelation coefficient is greater (in absolute value) than the limits of the confidence 
interval. In fact, the ACG and PACG help to identify the model:  
 

o If the PACF cuts off sharply after lag p and the ACF declines in geometric 
progression from its highest value at lag p, then the series can be modelled by 
an AR(p) model.  
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o If the ACF cuts off sharply after lag q and the PACF declines in geometric 
progression from its highest value at lag q, then the series can be modelled by 
an MA(q) model.  

o If the series is not stationary it needs to be differenced first (parameter d in an 
ARIMA (p,d,q) model indicates how often the series had to be differenced 
until it was stationary).  

 
The histogram shows if the residuals are normally distributed.  
 

 
 

 Decomposition (X11) shows the different tables produced by X11. Below you can see 
an A-Table as an example.  
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 A-Table: preliminary estimation of extreme values and calendar effects 
 B-Table: preliminary estimation of time series components 
 C-Table: final estimation of extreme values and calendar effects 
 D-Table: final estimation of the different components 
 E-Table: components modified for large extreme values 
Quality measures:  

Summary shows the quality of the seasonal adjustment. The values of the M-
statistics belong to [0,3], but must be <1 for a good quality. Q and Q without M2 is a 
composite indicator calculated from M statistics. They also have to be <1 for a good 
result.  
 

 
 

 Details  
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 Benchmarking displays the graphs and tables of the original and the benchmarked 
series and a graph and table of the differences between these 2 series. Maximum, 
minimum, average and standard deviation of the differences are calculated as well.  
 

 
 

 Diagnostics 
Here you will find again the diagnostics that you have already seen under Main results 
Diagnostics.  

 Seasonality tests 
Here you will find a few tests to check the presence of seasonality in your series:  
 

o Friedman test (test for stable seasonality),  
o Kruskall-Wallis test (test for stable seasonality),  
o Test for the presence of seasonality assuming stability,  
o Evolutive seasonality test (test for moving seasonality),  
o Combined seasonality test (combined seasonality test using Kuskall-Wallis test, 

Test for the presence of seasonality assuming stability and Evolutive seasonality 
test),  

o Residual seasonality test (for the seasonally adjusted series on the entire time span 
and on the last 3 years).  
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 Spectral analysis 
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Here you will find spectral plots to check the presence of remaining seasonal and trading 
day effects. 2 spectral plots are displayed: the periodogram and the auto-regressive 

spectrum. The graphics are available for the residuals (  Residuals), the irregular 
component (  Irregular) and the seasonally adjusted series (  Sa series (stationary)). 
The periodicity at frequency f is 2π/f, so we have 2 seasonal frequencies for quarterly 
series: π/2 and π. In the plots the blue-grey lines correspond to the seasonal frequencies 
and the red lines to the trading day frequencies. If we have a peak at a seasonal or a 
trading day frequency a better fitting model is needed. A peak at a seasonal frequency 
means that the filter used in the decomposition is not well adapted to the series. A peak at 
a trading day frequency means that the regression variables in the model are not well 
adapted or that the calendar effects are changing too much. The green horizontal line 
denotes the .005 significance level, so the peaks above this line are significant at a .005 
level. Note that you can Copy and Print all of these graphs.  
 

 
 

 Sliding spans analyses the stability of the seasonally adjusted series. These are 
supposed to be stable in the sense that adding or removing data points at the beginning or 
ending of the series doesn’t affect the seasonally adjusted series very much. Sliding spans 
allow you to detect significant changes in your series like seasonal breaks, large number 
of outliers and fast moving seasonality. A span is a range of data between 2 dates. 
Depending on the length of the original series, the sliding spans include 2, 3, or 4 
overlapping spans. The maximum of spans is set to 4 and the intervals, on which the 
spans begin, to 1 year. The Sliding spans summary shows the time spans used, tests for 
seasonality for each of these time spans and means of seasonal factors for each quarter in 
each span.  
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A more detailed analysis is given for the seasonal component (  Seasonal), the trading 
days effect (  Trading days) and the seasonally adjusted series (  SA series 
(changes)). For each of these you will find a sliding spans statistic, a cumulative 
frequency distribution of the sliding spans statistic and a table with the breakdowns of 
unstable factors and average maximum percentage differences across spans. The sliding 
spans statistic calculates the maximum percentage difference for each quarter. The 
cumulative frequency distribution of the sliding spans statistic uses a frequency polygon, 
where the x-axis shows the values of the sliding spans and the y-axis the frequency in 
percentage of each class interval. In the third panel the abnormal values indicate the 
percentage of values that do not meet the sliding spans condition. If the sliding spans 
statistic reveals a large number of unstable estimates, you should think about changing 
the model specification.  
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For a more detailed description of the tests you should have a look at the Demetra+ User 
Manuel or to the JDemetra+ User Manuel as soon as it will be available. Any Time Series 
Manuel will also give you the information needed on these tests.  
 
Let’s now consider how we can change a series with a Severe quality output. To do so 
we have to perform changes in the Spec Window:  
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First of all we can change the series span. This could be useful f. ex. in the case of a big 
financial crisis where you would like to split the series in 2 parts, one before and one after 
the crisis. However the model is supposed to be robust enough to deal with this without 
having to split the series and another problem could then be that you wouldn’t have 
enough data for a good model for one part of the series.  
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Another option is to restrict the model span, which is the data span on which your model 
will be based. This could be interesting f. ex. in the case of Quarterly National Accounts. 
In October each year annual data becomes available and this data is supposed to be less 
volatile than quarterly data, so you could fix your model during the whole year to this. 
The only problem is then that you can get higher revisions once you change the model in 
October of the following year.  
 

 
 
Considering the transformation node, you better leave this one untouched. Here you can 
force the transformation to a Log transformation but it is better to let the program detect 
the transformation needed. You can also change the Akaike difference and the 
Adjustment to Leap Year and to Length of Period, but so far this has not proved to be so 
useful to us.  
 

 
 
The regression node however is more interesting. Here you can define whether you want 
to adjust for trading days or not, apply your calendar, adjust for leap year, adjust for 
Easter, define the duration of Easter etc. You can also define pre-specified outliers, 
intervention variables, ramps and user-defined variables. All of these are very interesting 
f. ex. if you want to test the effect of a trading days adjustment, different calendars, 
adjustment for leap year or Easter and different sets of outliers, intervention variables, 
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ramps and user-defined variables on your series.  
 

 
 
The most important thing in the ARIMA node is the fact that you can enable or disable 
Automatic modelling. Sometimes, JDemetra+ tries to force a seasonal model on a series 
that is definitely not seasonal (already from a graphical point of view) and you will get a 
severe quality output. In this case you can chose to model the series yourself and set the 
BP, BD and BQ parameters to 0 so that your ARIMA model will not be seasonal any 
more. Usually you get a model of much better quality then.  
 

    
 
For the outliers you can specify amongst others the detection span for the outliers, 
whether a default critical value is used or if not the value of this one and the type of 
outliers detected (additive, level shift, transitory and seasonal).  
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In the X11 node you can specify the decomposition mode (Undefined, Additive, 
Multiplicative, LogAdditive), whether you want JDemetra+ to compute forecasts, the 
lower and upper sigma boundaries for the detection of extreme values, the kind of 
seasonal filter (=seasonal moving average) used to estimate the seasonal factors, whether 
the length of the Henderson filter used in the estimation of the trend is detected 
automatically or if not the length of it.  
 

 
 
In the Benchmarking node you can enable or disable benchmarking and fix the target to 
the original or calendar adjusted data, which means that you can determine whether the 
sum of quarters of the seasonally (and calendar) adjusted data equals the sum of quarters 
of the original data or the sum of quarters of the calendar adjusted data. Benchmarking 
makes sense if the annual totals in the Diagnostics basic checks are bad.  
 

 
 
Note that in the lower part of the Spec Window you can find a small window with the 
description of each element of the Spec Window.  
 
 
Before exporting the results, you need to save the Workspace. To do so go to the menu 
File -> Save Workspace As… and save it under the name and place you want.  
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Upon saving the Workspace, JDemetra+ creates automatically an .xml file of the same 
name than the Workspace and containing all the informations of this one. Besides a 
folder of the same name than the Workspace with the sub-folders Calendars, 
SAProcessing, X13Doc and X13Spec (or TramoSeatsDoc, TramoSeatsSpec if you have 
used a tramoseats specification) is created.  
To open a Workspace previously saved, go to the menu File -> Open Workspace or -> 
Open Recent Workspace and select the .xml file.  
 

 
 

Generating output 
 
To export the results, go to the menu SAProcessing-1 -> Output. .  
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The following type of files can be exported with JDemetra+:  
-Csv (Comma separated values) 
-Csv Matrix,  
-Excel and 
-Txt.  
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Usually Excel data is exported. Select Excel, and then double-click on the Excel icon on 
the left. Now you can define the folder where your output file will be saved to and the 
name of the exported file, under the node -> Location -> folder and ->File Name. If you 
want to get the same output structure as in the input file, you should choose under the 
node ->Layout -> layout ByComponent and tick -> verticalOrientation. For Quarterly 
National Accounts, the data sent to Eurostat include the raw/original data (y), the 
seasonally adjusted data (sa) and the working day corrected data (ycal). So you should 
select these under the node -> Content -> series. Note that many other series can be 
exported, like forecasts, trend, irregular etc.  
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The output option will create by default a folder of the same name than the Workspace (f. 
ex. Workspace_1) at the place defined under folder (in the example above 
C:\Users\velter\D…). In this folder, another folder of the name of the processing (f. ex. 
SAProcessing-1), which contains the series (in the above example ESA95_1_COP05…), 
can be found. Beware that, in contrast to Demetra 2.03, JDemetra+ drops empty columns 
from the input in the output, and so if you have series with no values at all in your input, 
they will automatically be cancelled out in the output. So you should use lookup formulas 
in any Excel files that use data from your output!  
In the output file seasonally adjusted data can be found on the sa sheet. Working day 
adjusted data will be on the ycal sheet whereas original data will be on the y sheet.  
Note also that in the output file the series have been shifted one column down compared 
to the output of Demetra 2.03. Now a new line with the title of the adjustment (sa, ycal or 
y) has been inserted at the beginning of each sheet. This is important in the case that any 
macros point on the data. If you haven’t saved your workspace yet, you should do this 
now. Your processing (in this case SAProcessing-1) will then be available for future 
refreshment in the Workspace Window under the node -> seasonal adjustment -> 
specifications -> multi-documents -> SAProcessing-1.  
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Reopen a JDemetra+ processing 
 
In Luxembourg’s Quarterly National Accounts, parameters chosen by JDemetra+ for 
seasonal and calendar adjustment are only changed as new annual data becomes 
available, which means that the exercise above is only repeated at annual frequencies in 
October. For the other compilations of QNA data (in January, April and July) the model 
chosen remains the same, but new data is taken into account (same model span, new time 
span). To do so, select the previously seasonally adjusted file in the Workspace Window 
under the node -> Seasonal Adjustment -> multi-documents by double-clicking on it.  
 
The corresponding SAProcessing will open then in the window on the right. Select all the 
series in this processing, right-click and select -> Refresh -> Current adjustment (partial). 
The series are then seasonally adjusted based on the former parameters, but integrating 
the new data.  
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Note that you only need to update your Excel file with the new data and not to import it 
again in JDemetra+ as this is done automatically in the Providers window.  
 

Appendix 
 
JDemetra+ can be downloaded here:  
http://www.cros-portal.eu/content/jdemetra-java-version-including-source-codes.  
 
A User Manuel for JDemetra+ is not yet available, but will be soon. Meanwhile the User 
Manuel of Demetra+ can help out:  
http://www.cros-portal.eu/sites/default/files/Demetra+%20User%20Manual.pdf.  
 
Eurostat offers a variety of courses on seasonal adjustment and on the use of JDemetra+ 
several times a year. For the exact dates and registration please check out the following 
link:  
http://epp.eurostat.ec.europa.eu/portal/page/portal/pgp_ess/about_ess/estp.  
 
In case of specific questions on JDemetra+ please contact the Eurostat helpdesk under: 
estat-methodology@ec.europa.eu.  

http://www.cros-portal.eu/content/jdemetra-java-version-including-source-codes
http://www.cros-portal.eu/sites/default/files/Demetra+%20User%20Manual.pdf
http://epp.eurostat.ec.europa.eu/portal/page/portal/pgp_ess/about_ess/estp
mailto:estat-methodology@ec.europa.eu

